CHAPTER 7

Resource Library

Using the Resource Library

This tab includes resources to help you learn more about Cisco Unified Communications.
e Cisco Unified Communications System Description
e Cisco Unified Communications System Release Notes
e Network Topology Resources
e Ordering Guides
e Troubleshooting Individual Components
e Component Resources
¢ Configuration Command Files
e System Test Results
e End-of-Sale and End-of-Life

e (Cisco Unified Communications System Demo

Cisco Unified Communications System Description

Cisco Unified Communications System Description (right-click to download PDF)

Cisco Unified Communications System Release Notes

System Release Notes for Contact Center: Cisco Unified Communications Release 5.1(1)

System Release Notes for IP Telephony: Cisco Unified Communications Release 5.1(1)

Network Topology Resources

This topic provides topology resources you can use to document network plans. Specifically, it includes:
e Microsoft Visio Contact Center Topology Diagrams as individual Microsoft Visio files

e How to Use Microsoft Visio Drawings Efficiently—Guidelines for best practices in using Microsoft
Visio files
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Microsoft Visio Contact Center Topology Diagrams

You can download zip files containing Visio drawings of the logical and physical topologies for the
contact center that are documented on the Prepare and Plan tab. Table 7-1 identifies the Visio drawings
in each zip file.

Note  You need Microsoft Visio 2003 to open the files.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at:

http://www.cisco.com/en/US/products/prod_visio_icon_list.html

Table 7-1 Microsoft Visio Logical and Physical Topology Diagrams

Description Filename

Zip file includes logical and physical Oxf_TB1_Topos.zip (right-click to download zip)
drawings in Test Bed 1 as listed below. 7.2 MB

Note If you click the link rather than right-click, the
zip file may open in the secondary window but
also replace the contents of this window. Use
your Back button to return to this window.

Unified IP IVR Sites in Test Bed 1

Oxf_IPCC_CCM_Logical_ALL.vsd

Parent and Child Sites in Test Bed 1

Oxf_IPCC_CCM_Logical_PC.vsd

Site 1 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Sitel.vsd

Site 2 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site2.vsd

Site 3 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site3.vsd

Site 4 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site4.vsd

Site 5 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site5.vsd

Site 6 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site6.vsd

Site 7 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site7.vsd

Site 8 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site8.vsd

Site 9 IP IVR Logical Topology

Oxf_IPCC_CCM_Logical_Site9.vsd

Site 1 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Sitel.vsd

Site 2 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site2.vsd

Site 3 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site3.vsd

Site 4 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site4.vsd

Site 5 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site5.vsd

Site 6 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site6.vsd

Site 7 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site7.vsd

Site 8 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site8.vsd

Site 9 IP IVR Physical Topology

Oxf_IPCC_CCM_Physical_Site9.vsd
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Table 7-1 Microsoft Visio Logical and Physical Topology Diagrams (continued)
Description Filename
Zip file includes logical and physical Oxf_TB2_Topos.zip (right-click to download zip)
drawings in Test Bed 2 as listed below. 7.8 MB
Note If you click the link rather than right-click, the
zip file may open in the secondary window but
also replace the contents of this window. Use
your Back button to return to this window.
Unified CVP Sites in Test Bed 2 Oxf_IPCC_CVP_Logical_ALL.vsd
Site 1 CVP Logical Topology Oxf_IPCC_CVP_Logical_Sitel.vsd
Site 3 CVP Logical Topology Oxf_IPCC_CVP_Logical_Site3.vsd
Site 5 CVP Logical Topology Oxf_IPCC_CVP_Logical_Site5.vsd
Site 6 CVP Logical Topology Oxf_IPCC_CVP_Logical_Site6.vsd
Site 7 CVP Logical Topology Oxf_IPCC_CVP_Logical_Site7.vsd
Site 8 CVP Logical Topology Oxf_IPCC_CVP_Logical_Site8.vsd
Site 1 CVP Physical Topology Oxf_IPCC_CVP_Physical_Sitel.vsd
Site 3 CVP Physical Topology Oxf_IPCC_CVP_Physical_Site3.vsd
Site 5 CVP Physical Topology Oxf_IPCC_CVP_Physical_Site5.vsd
Site 6 CVP Physical Topology Oxf_IPCC_CVP_Physical_Site6.vsd
Site 7 CVP Physical Topology Oxf_IPCC_CVP_Physical_Site7.vsd
Site 8 CVP Physical Topology Oxf_IPCC_CVP_Physical_Site8.vsd

How to Use Microsoft Visio Drawings Efficiently

Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word,
PowerPoint). Unfortunately, the default method is to insert the whole “Visio object” into a file. This can
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the
application data with the drawing. This object information is needed if you want to be able to
double-click the drawing from Word or PowerPoint and have it open in Visio for editing. But pasting as
an object adds many megabytes to the size of your file. With only a few such drawings, a Word document
can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers and a trial
for partners or customers to download. (They might even give up before it is done.) In addition, very
large documents are more problem-prone.

Bringing a Visio Drawing into a Document

Step 1
Step 2

Unless you really need the live editing capability, avoid unnecessary file bloating by performing an extra
step when you paste.

In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special
dialog box, choose Picture (Windows Metafile).

Cisco Unified Communications System for Contact Center Release 5.1(1)
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Step 3

Paste Special
Source:  Visio 2000 Drawing

?IX
C:\Documents and SettingsihweisertiMy D
:

(%) Paste:
() Paste fink:

Result
Insarts the contents of the Clipboard a5 & wandows
metafils picture,

Click OK. The drawing pastes as an ordinary picture. If it is not positioned properly, choose Format >
Picture, click the Layout tab and select In line with text. This is generally the most reliable layout
option.

The Bottom Line
Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special.

Downsizing Existing Drawings

Step 1

Step 2

Tip

If a document is larger than it should be, you can check to see if the Visio drawings are the reason and,
if so, fix the problem.

With the drawing selected in the Word or PowerPoint document, choose Edit. At the bottom of the Edit
menu, you will see one of the following:

e Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much
more file space than it needs to. Go on to Step 2.

e Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file
size.

If the drawing is an object, cut it (Ctrl-X), and then repaste as in Bringing a Visio Drawing into a
Document.

You can easily click through the document to check each picture by using Word's handy Go To feature:
Where you want to start searching, press Ctrl-G. In the Go To What list, select Graphic and click Next.
You go to the next graphic. Click it to select and then check as in Step 1. If needed, repaste as in Step 2.
Click Next and continue these steps for other graphics.

Cisco Unified Communications System for Contact Center Release 5.1(1)
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Ordering Guides

Ordering guides for most Cisco Unified Communications products are available for partners and Cisco
employees.

Software Bundles
e Unified Communications Solution Bundle [INTERNAL]

Call Control, End Points, and Call Control Applications
e Cisco Unified CallManager 5.0 [INTERNAL]

e Cisco Unified IP Phones [INTERNAL]
e Cisco CallManager Express &
 Cisco Unified Survivable Remote Site Telephony (SRST) &'

Contact Center
e Cisco Customer Contact Center Business Unit Price List &' (right-click to download PDF)

This list addresses pricing and packaging structure for all Contact Center products.

Conferencing
e Cisco Unified MeetingPlace [INTERNAL] (right-click to download PDF)

e Cisco Unified MeetingPlace Express & (right-click to download PDF)

Messaging
e Cisco Unity & (right-click to download PDF)
e Cisco Unity Connection & (right-click to download PDF)

Troubleshooting Individual Components

For a list of the diagnostic tools and supporting troubleshooting documentation available for most
components in a contact center network, see Contact Center Component Troubleshooting Tools and
Documentation on the Implement tab.

To search for support for a product or to find technical information on products, solutions, and
technologies, go to the following URL:

http://www-tac.cisco.com/Support_Library

Component Resources

The following list provides links to the main page for documentation on various Cisco Unified
Communications components, from which you can navigate to individual documents. For documentation
on specific tasks, see the relevant topic, such as Component Installation and Configuration Guides on
the Implement tab.

Voice Documentation
http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html
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Cisco Unified CallManager
http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

Cisco Unified IP Phone

http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

Cisco Unified Intelligent Contact Management/Unified Contact Center Enterprise Edition

http://www.cisco.com/en/US/products/sw/custcosw/ps1001/tsd_products_support_series_home.html

Cisco Unified Contact Center Enterprise
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/tsd_products_support_series_home.html

Cisco Unified Operations Manager
http://www.cisco.com/en/US/products/ps6535/tsd_products_support_series_home.html

Cisco Unity Connection
http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html

Customer Response Solutions

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html

Cisco Unified Customer Voice Portal

http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_series_home.html

Cisco Telephony Integration Object Server
http://www.cisco.com/en/US/products/sw/custcosw/ps14/tsd_products_support_series_home.html

Cisco Agent Desktop

http://www.cisco.com/en/US/products/sw/custcosw/ps427/tsd_products_support_series_home.html

Cisco Unified Mobile Agent
http://www.cisco.com/en/US/products/ps6223/tsd_products_support_series_home.html

Cisco Security Agents

http://www.cisco.com/en/US/products/sw/secursw/ps5057/tsd_products_support_series_home.html

CiscoWorks Management Center for Cisco Security Agents
http://www.cisco.com/en/US/products/sw/cscowork/ps5212/tsd_products_support_series_home.html

Cisco Catalyst 3550 Series Switches
http://www.cisco.com/en/US/products/hw/switches/ps646/tsd_products_support_series_home.html

Cisco Catalyst 6500 Series Switches Install and Upgrade Guides
http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.html

Cisco CSS 11000 Series Content Services Switches

http://www.cisco.com/en/US/products/hw/contnetw/ps789/tsd_products_support_eol_series_home.ht
ml
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Cisco 7800 Series Media Convergence Servers Guides
http://www.cisco.com/en/US/products/hw/voiceapp/ps378/tsd_products_support_series_home.html

Cisco AS5400 Series Universal Gateways
http://www.cisco.com/en/US/products/hw/univgate/ps505/tsd_products_support_series_home.html

Cisco AS5800 Series Universal Gateways
http://www.cisco.com/en/US/products/hw/univgate/ps509/tsd_products_support_series_home.html

Cisco 3600 Series Multiservice Platforms
http://www.cisco.com/en/US/products/hw/routers/ps274/index.html

Cisco 3700 Series Multiservice Access Routers

http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html

Cisco 3800 Series Integrated Services Routers
http://www.cisco.com/en/US/products/ps5855/tsd_products_support_series_home.html

Cisco 10S Software Release 12.4 T
http://www.cisco.com/en/US/products/ps6350/tsd_products_support_series_home.html

Configuration Command Files

You can download sample configuration files for the call flow components described in Tested Call

Flows.

Table 7-2 Sample Call Flow Component Configuration Files

Description Filename

Test Bed 1 Call Flows: Cisco Unified CallManager |Oxf TB1_Configs.zip (right-click to

Post-Routed Call Flow Components download zip) includes the files below.

Note If you click the link rather than

right-click, the zip file may open in
the secondary window but also
replace the contents of this window.
Use your Back button to return to
this window.

Sitel Cisco 3660 Gatekeeperl cs1-3660-gkl1-confg

Sitel Cisco 3660 Gatekeeper2 cs1-3660-gk2-confg

Sitel Cisco 3660 Gatekeeper3 cs1-3660-gk3-confg

Sitel Cisco 3745 Gateway1 cs1-3745-gwl-confg

Sitel Cisco CMM Gatewayl csl-cmm-gwl-confg

Sitel Cisco CMM Gateway?2 csl-cmm-gw2-confg

Site3 Cisco 3725 Gateway1 cs3-3725-gwl-confg

Site4 Cisco 3660 Gatekeeperl cs4-3660-gk1-confg

Cisco Unified Communications System for Contact Center Release 5.1(1)
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Table 7-2 Sample Call Flow Component Configuration Files (continued)

Filename
cs4-3660-gk2-confg
cs4-3660-gk3-confg
cs4-3745-gwl-confg
cs4-5850-gw1-confg

cs5-cmm-gw 1-confg

Description

Site4 Cisco 3660 Gatekeeper2
Site4 Cisco 3660 Gatekeeper3
Site4 Cisco 3745 Gatewayl
Site4 Cisco 5850 Gateway1
Site5 Cisco CMM Gateway 1
Site6 Cisco 3745 Gatewayl
Site6 Cisco 3745 Gateway?2
Site9 Cisco 3660 Gatekeeperl
Site9 Cisco CMM Gateway1

Test Bed 2 Call Flows: Cisco Unified Customer Voice
Portal Post-Routed Call Flow Components

cs6-3745-gwl-confg
cs6-3745-gw2-confg
¢s9-3660-gk1-confg
cs9-cmm-gw I-confg

Oxf_TB2_Configs.zip (right-click to
download zip) includes the files below.

Note If you click the link rather than
right-click, the zip file may open in
the secondary window but also
replace the contents of this window.
Use your Back button to return to

this window.
ps1-3660-gkl-confg
ps1-3660-gk2-confg
ps1-6509-SW1-confg
ps1-7206-confg

Sitel Cisco 3660 Gatekeeperl
Sitel Cisco 3660 Gatekeeper2
Sitel Cisco 6509 Switchl

Sitel Cisco 7206 VXR Router

Sitel Cisco Content Services Switchl

psl-cssl-confg

Site3 Cisco AS5400HPX Gateway2

ps3-5400-gw2-confg

Site3 Cisco AS5400HPX Gateway3

ps3-5400-gw3-confg

Site3 Cisco 6506 Router

ps3-6506-rtr-confg

Site3 Cisco 6506 Switchl

ps3-6506-SW 1-confg

Site5 Cisco 6509 Router

ps5-6509-rtr-confg

Site5 Cisco Content Services Switch2

ps5-css2-confg

Site6 Cisco AS5400HPX Gateway2

ps6-5400-gw2-confg

Site6 Cisco AS5400HPX Gateway3

ps6-5400-gw3-confg

Site6 Cisco AS5400HPX Gateway4

ps6-5400-gw4-confg

Site6 Cisco AS5400HPX Gateway5

ps6-5400-gw5-confg

System Test Results

This topic summarizes the results of Cisco Unified Communications Release 5.1(1) system testing for
contact center environments. This topic contains the following sections:

e Testing Objectives

[l Cisco Unified Communications System for Contact Center Release 5.1(1)
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e Tested Deployment Models and Sites
e Test Results

Testing Objectives

Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring,
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of
system testing is to validate the seamless interoperability and stability of the components that make up
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

¢ Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the
system level and usability for system components

e End-to-End Functionality Testing—To verify the end-to-end functionality of system components
e Basic Functionality and Feature Testing—To verify basic call flows and component features

e Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios based
on TAC input

¢ Interoperability Testing—To verify the interoperability among system components
e Scalability Testing—To verify system functionality during scalability tests

e Performance, Load, and Stress Testing—To verify system functionality during performance, load,
and stress tests

e Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and
recovery, and behavior in redundant configurations

Tested Deployment Models and Sites

Test Results

Several deployment models and sites were designed and tested as part of Cisco Unified Communications
System Release 5.1(1) for Contact Center. For information about the hardware and software
components, configurations, and environment tested and verified for interoperability in Cisco Unified
Communications Release 5.1(1), see Test Deployment Models and Sites.

The results of the system tests performed for contact center during Cisco Unified Communications
Release 5.1(1) are shown in the System Test Results (right-click to download PDF).

The test results contain the following information:
e Title—Title of the test.
e [D—Identifier for the test.
¢ Description—Description of the purpose of the test.
e Features Tested—Component feature tested.
e Status—Result of the test and any defects related to the test case. Possible values are:
— Passed—Test case passed as described in the table.

— Failed—Test case failed and the reason is described in the listed defect.

Cisco Unified Communications System for Contact Center Release 5.1(1)
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— Passed with exception—Test case as described passed but an anomaly occurred that was not
directly related to the functionality being tested. Possible anomalies are as follows:

The test steps were modified based on the actual feature implementation.
The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as
required.

e Defects—Identifier for any defect that was opened against the test. If you have an account with
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:
http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl &

End-of-Sale and End-of-Life

The end-of-sale (EOS) date is the last date to order the product through Cisco point-of-sale mechanisms.
The product is no longer for sale. There is also an end-of-life (EOL) process that guides the final business
operations associated with the product life cycle.

The EOL process consists of a series of technical and business milestones and activities that, once
completed, make a product obsolete. Once obsolete, the product is not sold, manufactured, improved,
repaired, maintained, or supported.

For information about recommended replacements, see the comprehensive list of announcements at the
following URL:

http://www.cisco.com/en/US/products/prod_end_of_life.html

For information on specific products, choose a product from the following URL.:
http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

Then click on the End-of-Life and End-of-Sale Notices link in the Product Literature box.

For an overview of the Products and Services EOL policy, see the information at the following URL.:

http://www.cisco.com/en/US/products/products_end-of-life_policy.html

Cisco Unified Communications System Demo

The Cisco Unified Communications System Demo describes the various methods that are available for
use by Cisco field offices worldwide to demonstrate the Cisco Unified Communications system.

Cisco Unified Communications System Demonstration [INTERNAL]

Cisco Unified Communications System for Contact Center Release 5.1(1)
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